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Now that you have installed ATS, you are ready to begin using the system. This brief Quick Start
Overview and the following User Manual provide the general information needed to begin entering
data into the system and using ATS for the first time. This User Manual is for all Editions of Asset
Tracking. Features will vary based off your purchased Edition.

ASSET TYPES AND CLASSIFICATIONS

This function allows you to create classifications and types within each classification. Classifications (i.e.
Office Equipment) and (sub-) Types (i.e. Desks, Chairs, etc.) are used to categorize assets. On the menu
bar select Support > Asset Support Administration. You can rename the Classifications and Types
designators in the Setup Options function if desired. See Asset Support Administration in the User
Manual for more information.

USER DEFINED FIELDS (PRO AND CONTRACTOR EDITION ONLY)

This features allows you to create extra fields to track your assets by. User Defined Fields are tied to the
Type of asset in the system and are unlimited. You can enter new User Defined Field names in
Support—=>Asset Support Administration—=> User Defined Fields. Here you will enter the title field names.
You will not enter specific User Defined Data until you enter an asset into the system.

MAINTENANCE (PRO AND SCHOOL EDITION ONLY)

The maintenance function of the system allows users to keep track of necessary maintenance for each
of their assets. Maintenance is tied to the different classes and types of the asset. On the menu bar,
select Support—>Maintenance/Repair Provider Administration. See this section in the User Manual for
more detailed information.

CONDITIONS

Add any number of Conditions that you desire (Excellent, Good, Poor, etc.) This is a searchable field
and can be invaluable to locate equipment needing replacement, etc. See Support—> Condition
Administration for additional information.

FUNDING SOURCE AND ACCOUNTS

The Funding Source is a standalone field that can be setup by you to use as needed. You can also
rename the Funding Source in the Setup Options function if desired. The Accounts screen allows you to
tie each Asset to an account number for added filtering. See Support—>Funding Source Administration
and Account Administration for more information.

FACILITIES

This function allows you to enter facilities, which are used to organize asset locations. On the menu bar
select Support->Facility Administration. See Facility Administration in the User Manual for a detailed
explanation.
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LOCATIONS

This function allows the user to create locations where assets are stored or to which assets are checked
out. Locations can also be classified as “Storage” locations. Storage locations are typically where
materials are centrally located until checkout. On the menu bar select Support—> Location
Administration. See Location Administration in the User Manual for a detailed explanation.

EMPLOYEES

This function has you enter employees. An employee may be an individual that will be using the ATS
system or a person to which assets may be checked out. You can set ATS Access Rights for each
employee here also. On the menu bar select File>Employee Administration. See Employee
Administration in the User Manual for a detailed explanation.

MEMBERS (SCHOOL EDITION ONLY)

This function is used to create members other than employees. A member is an individual to which
assets may be checked out or assigned. You can set Member Categories in the Setup Options screen,
and then add members under the Members screen.

PRINTER ASSIGNMENT

This function allows the user to specify which windows printer will be used for report printing and
which one will be used for label printing. This function must be set on each workstation before
printing. On the menu bar select File>Printer Assignment. See Printer Assignment in the User Manual
for a detailed explanation.

LABEL DESIGN

The system allows the user to design labels for assets, locations, and employees. These labels typically
have barcodes and can be used to audit, check in, and check out assets. Several sample label designs
are included and can be modified. You must select a default label format in the Label Setup function
before printing is allowed. On the menu bar select Labels—> Label Designer. See Label Designer and
Label Setup in the User Manual for a detailed explanation.

ASSETS

The asset administration screen allows for the creation and history of assets which are tracked by this
system. On the main button bar select the Asset button. See Asset Management in the User Manual
for a detailed explanation.

Once you have setup your initial data, you are ready to start using ATS! Check out assets to employees
or locations. You can also check assets back “in” to storage. Be diligent on how you use the system and
it will provide years of reliable tracking of all of your assets!
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Backup your database daily!

LegIn

Login

Enter your user name and password to log in.

User Name: |

Password: |

‘(ﬁ/ Log In ‘-ﬂ Exit ‘

— -
Registration

Registered Owner License

Customer IDENT: ||

License Key: | | | |

[ clear ] [ Reamer | [ conol ]

" Upon opening the program, the screen at left will appear.

You will be prompted to enter a User Name and Password.
If it is the first time logging in, you will use the Admin
User’s data:

Username: ADMIN
Password: ADMINUSER

Other users may be added to the system after setup. After
users are entered into the system, they should each log in
under their own User Name and Password.

After logging in as Admin, click File on the menu and select
Registration Form. This step is important because it assigns
licensing rights to you. Entering the information will unlock
the program for your licensed use.

The Four Digit Customer Identifier and the 16 digit License
Key will be provided by Gigatrak when the product is
purchased.

After registering your product, click File on the menu and select Setup Options. (Setup Options can only

be accessed when logged in as Admin.)
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[% Setup Options

Setup Options
Edition

" Starter (" Basic " Pro & School

Asset Setup (F1) Application Settings (F2)

Rename Classification: ,W
Rename Type: 'Type—
Rename Facility: [Facllty
Rename Location: 'Lumﬁun—

o o

Member Setup (F3)

This option can be used to change the
names of the parameters to fit your
needs This makes up the structure of the
system. Classification, Type, Facility,
Location, and Funding Source are
parameters tied to assets. Model

Rename Funding Source: W
Rename Model Number: [Product Number
Rename Serial Number: [Serial Number

Rename Condition: W
Service Reminder Interval: ,3[]—
Root Image Folder: |C-\Users\AshlynnR\Docume D

Root Document Folder: ,75
Custom Report Folder: ,75
gL;éi‘.?“. Report Logo: ,75

Number, Serial Number, Account, and
Condition can be renamed to suit your
needs.

Report Auto E-mail Setup
SMIPHost [
From E-mail Address- [
SMTP User Name: [~
SMTP Password: [

Use SSL/TLS: [

If you would like to alter any of the
names, type in the desired value and
then click the OK button.

The Service Reminder Interval is used to
calculate how soon in advance you will be notified when Asset Maintenance is coming due. The default
setting is 30 days. (Pro and School edition only)

The Root Image Folder is the default location for images that you wish to tie to an asset. If the image is
in the default location, only the file name is required in the asset screen to identify the image.

The Custom Report Folder is the location for custom report files. If a custom report is ordered, the
report file should be placed in a folder, and the path to the folder should be set in this option.

The Report Logo allows the display of a company logo on reports. You can select a .bmp, .gif, or .jpg file.
To clear a logo after it is selected, click the “Select” button and click Cancel on the selection screen.

Application Settings control various functions in the asset tracking application.
SHOW DEPRECIATION

I Setup Opti =
e e an B

If Show Depreciation is checked, then the

Setup O — s - . . . . . . .
Fiion] | depreciation information will be visible on the
& Stari | [This Depreciation Function, including access to formulas used for the computations provided 7 (el

herein. is provided by GigaTrak solely for your canvenience and for illustration purposes anly.
GigaTrak is not licensed or qualified to give, and is not providing to you, any legal, tax.
financial reporting or accounting advice. GigaTrak does not guaranty the accuracy of
= Show| | [the COmputations Furthermore, GigaTralk can not be aware of any customer's particular
circumstances and GigaTrak does not purport to keep up to date with any tax, financial
W Allow| | |reporting or standards or req . The contained herein is
not guaranteed to be correct, complete or up to date. Accordingly, you should consult
W Relo . . :
with your own legal, tax, financial reporting and accounting advisors. GigaTrak is
I~ Auto| [not responsible for any loss, injury, claim, liability or damage related to your use of this
Depreciation Function or the output hereof and by your use of this Depreciation Function
I Displ
lyou waive and release GigaTrak from any such loss, injury, claim, liability or damage.
Iv Displd | [You use this Depreciation Function at your own risk and the correctness and usability
of the output hereof remains your sole responsibility.

Asset information screen. The Asset
Depreciation Report will also be available on

the Reports screen. If the checkbox is not
checked, the depreciation information will not
be visible and the depreciation report will not

GigaTrak is not licensed or qualified to give, and is not providing to you, any legal, tax,

I Sho financial reporting or accounting advice. | be Shown
-
€ I agres to the terms of this disclaimer
€ 1 do not agree to the terms of this disclaimer The checkbox cannot be checked until you
& o accept the disclaimer.
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After accepting the disclaimer, the Preferred Depreciation Type selection will be enabled. This will be
the default selection when adding new assets on the Asset Information screen.

ALLOW DELETE ASSET & PURGE HISTORY

If checked, then the Delete button will be displayed on the Assets screen and the Purge History button
will be displayed on the Asset History and the File tab. If the checkbox is not checked, the Delete button
and the Purge buttons will not be displayed.

RELOCATE ASSETS

If Relocate Assets is checked, the Check In/Out function will change to a relocate function. This option
does not use storage locations and does not allow entry or tracking of binned items. Assets are
relocated from one location (or person) to another location (or person) without being returned to a
storage location.

AUTO-POPULATE ASSET FIND TABS

When checked, the system will automatically display information when a Find screen is opened. If not
checked, you must first click “Extract Data” to view a listing.

DISPLAY EMPLOYEE BARCODES BEFORE NAMES

This applies to several report selection filters. If you view employees primarily by their names, leave
this unchecked. If you prefer tracking employees by the Barcode ID, then check the checkbox.

DISPLAY ACCOUNT NUMBERS BEFORE DESCRIPTIONS

The same rules apply to this option. Select how you prefer to view your report filters here. If you will
view accounts by descriptions, leave this unchecked. If you prefer tracking accounts by numbers, check
the box.

AUTO-CREATE “REPAIR” MAINTENANCE TYPE (PRO AND SCHOOL EDITION ONLY)

Checking this box will insert a “repair” maintenance item any time a new Classification and Type of
equipment is created.

SHOW MAINTENANCE DUE REPORT AFTER LOG IN (PRO AND SCHOOL EDITION ONLY)

By selecting this option, the report of any upcoming maintenance items automatically displays
immediately following log in.

SHOW BIN ASSETS BELOW REORDER POINT REPORT AFTER LOG IN

By selecting this option, the system will automatically display the report of any binned items below the
reorder point immediately following log in.
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REQUIRE CHECK IN BEFORE ANOTHER CHECK OUT

Checking this box will require a checked out asset to be checked back in to the storage location before
it can be checked out again. Leaving this unchecked will allow an asset to be checked out from person
to person (or location to location) without being returned to the storage location.

SHOW MAINTENANCE ON HANDHELD (PRO AND SCHOOL EDITION ONLY)

This option allows users to enter maintenance information on the mobile handheld terminal. If not
selected, the maintenance function will not appear on the mobile handheld terminal.

AUTO E-MAIL EMPLOYEE UPON CHECK OUT (PRO AND SCHOOL EDITION ONLY)

Checking this option will e-mail an employee a report of what they checked out through the system.
This feature can be used if you use Microsoft Outlook and connect the systems. In addition to this
Option being checked, your IT department must also input your SMTP host and “From” Email Address
on the F1 (Asset Setup) screen in the Setup Options. An Employee must also have an Email Address in
their Employee Profile.

LOG IN/PASSWORD SETTINGS

Single Sign On -This option allows a user to be automatically logged in to the ATS System without
having to enter a Username or Password. For this option to work, the box must be checked and the
Employee’s Login Username in their Employee Administration profile must match their Log In
Username to their computer.

Change Password — Check this option if you would like any User who is logged in to be able to change
their Password. A Change Password option will then appear in the File tab. If not checked, the
Password will need to be changed by someone with Edit rights to Employee Administration.

Password Policy — This option allows you to select any number of minimum requirements to make
passwords more secure when accessing the system.
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The School Edition allows users to manage up
to three types of “Members” of your own
definition. This could include Faculty, Staff,
Teachers, Students, etc.

You can rename the Member field at the top of
the tab to your choice of field. Renaming the
field and saving changes will make the changes
consistent throughout the system.

Category names can also be renamed and act as
an additional field by which you can search
throughout the system.

["% Setup Options

=

Setup Options
Edition
© Stafer " Basic " Pro @ School

Asset Setup (F1) Application Settings (F2)

Show Members: [#  Rename Member: Member
Category Names
Rename Category 1: [Student
Rename Category 2. [Facuty
Rename Category 3. [Staf

Member Setup (F3)

Additional Information Fields

Rename Info Field 1: [Subject
Rename Info Field 2. info Field2
Rename Info Field 3: [info Field3
Rename Info Field 4: [info Fieldd

o

The Additional Information fields give four optional searchable fields for members.

To save the changes for both tabs on the screen, select the OK button. A confirmation message will

appear, listing the items that you altered. Selecting “Yes” will save the changes and close the screen.

Selecting “No” will reset the changes back to the original values.

To leave the screen without changing any values, select the

screen.

in the upper right corner of the

The printer assignment process is used to set the printer the system will use for barcode labels. Select
Printer Assignment from the File menu and the screen below will be displayed.

f_‘_” Printer Assignment 5

Printer Assignment

Available Printers

Not Available

Microsoft XPS Document Writer

HP Color LaserJet Pro MFP M476 PCL 6
Fax

Brother HL-2140 series

doPDF 8 h

m|»

r—'%:r Assign Label Printer

Label Printer: ZDesigner TLP 2824 Plus (ZPL}

velz

' The Available Printers list will display all the printers

that are on the Windows printer list.

To select the label printer, select the printer of choice

and then click the Assign Label Printer button. The
Label Printer label will indicate the printer you
selected. Any labels printed by the system will be
directed to this printer. If you do not have a label
printer, assign the default printer to act as the label
printer.

ATS USER MANUAL
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Employees are either people that have access to the ATS system or people to whom assets will be
assigned. To manage employees, select Employee Administration under the File menu.

';’» Employee Administration

=3

Employee Administration

=]
Employee: | I Export To File

lv%b Add] I//‘ Edill [‘)\( Delele‘
IO Print Barcode List |

Jones, Sean E005
Owen, Miles E004
Smith, John E001
User, Admin

Wilson, Eric E003

Active?

Name Barcode
Doc, May

Yes
Yes
Yes
Yes
Yes

6 rows found

Upon initial setup, the only employee
will be the Admin user. You may Add,
Edit, or Delete employee information.

To Add a new employee, select the Add
button. The form will change as
indicated. The items in bold text are
required for all employees.

The system will not allow editing of the
last name, first name, middle initial, or
user name for Admin User.

To delete an employee, select the
employee and then select the delete
button.

If an employee is assigned an asset or has an outstanding reservation or is involved in a history record,
the system will not allow the employee to be deleted. Set the Status to inactive to prevent further use.

To print employee labels, select the employee(s) to be printed and then select the Print Label button. If
a label printer has been selected and if a default employee label has been designated (see Label

Designer in this manual), the label(s) will be printed.

For label printing, multiple employees may be selected. To select multiple employees, do one of the

following:

e Dragthe mouse over the employees desired while holding down the left mouse button.

o Select the first employee by left clicking with the mouse. Select the last employee in a range
by holding down the Shift key and the left clicking on the last employee. All employees in
between will be selected.

e Hold down the Control (Ctrl) key and select the employees you wish to print by left clicking
on each one with the mouse.

velz
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Enter the appropriate employee information. A few fields have special requirements:

-, -
%, Employee Administration

Employee Administration

Employee Info

rﬂ Save

Firs%lame: |

Last Name: |

Middle Initial:

Barcode: |

Log in Name:

(Min. 5 characters)

Password:

(Min. & characters)

Phone: |

Alt. Phone: |

E-mail: |

Notes:

EMPLOYEE ACCESS LEVELS

The barcode entry must be unique. A barcode for an asset,
location, or employee cannot be the same. Keep the barcode
as simple as possible, only using a short combination of
capital letters and numbers. If you use the supplied barcode
labels, the employee's barcode must match the label placed
on their badge.

If the employee will be using the ATS system, he will require
a Log in Name and Password.

The Log in Name must be between 5 and 10 characters long.
It must be unique; no two employees may have the same log
in name. Log in names are not case sensitive.

A password must be between 5 and 10 characters long.
Passwords are not case sensitive.

Once the employee information is entered, set the employee's access levels. The default access level is

for no access to ATS.

¢, Employee Administration

I"e=

Employee Administration

Employee Info

First Name: [Mary

Last Name: [Doe

Middle Initial

Barcode: [E002

Lag in Name: [MARYDOE
(Min. Scharacters)

oword [

Pas:
(Min. 5 characters)

Phone: |

Alt. Phane: |

E-mail- |

Notes. - Status
& Active
" Inactive

velz

Access Levels

Asset Administration - applies to
activities associated with creating and
editing asset data.

Asset Administration

& No

© View  Edit

Asset Reservation — applies to the

Asset Reservation

 No

Asset Check In / Check Out

" No

* View  Edit

activities where an individual may reserve
an asset for a period of time.

& Edit

Asset Support Administration

& No

 View o Edit

Asset Check In/Check Out- applies to

Employee Administration

@« Mo

Member Administration

@« Mo

 View  Edit

activities associated with assigning assets
to an individual or location, or returning

 View  Edit

assets to storage.
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9 Backup / Compact Database = | Asset Support Administration - applies to activities that

Backup | Compact Database support the overall asset process. This will include
This procedure will repair many database errors as well as reduce ma naging faCi“tieS, |0Cati0ns, asset types, CIaSSiﬁcationS,
overall database size by removing deleted and duplicate records. L. .
It will also create a backup copy of the current database in the a nd Cond 1tions. (Eve rythlng u nder the Su pport ta b)

‘dbbackup’ folder.

The system will keep the last 3 backup copies of the database.

The oldest file will be defeted. Employee Administration— applies to activities associated

To repairfcompact the database, click the Compact Database button. with ma nagi ngem ployee information.

Select the access level appropriate for the employee in

qguestion and then select the OK button.

Member Administration — applies to activities associated
with creating and editing member information. (School Edition Only)

To save the employee information, including the access level changes, select the Save button. Selecting
the Cancel button will leave the present process without saving the employee information.

If the employee logged into the system only has view rights to Employees, the “add”, “edit”, and
“delete” buttons will not be available. Instead, a “View” button will be available to allow the user to
look at employee information without changing any data.

To leave the process, select the in the upper right corner of the screen.

If you have the Access version of ATS, this option is used to periodically repair, compact, and backup the
ATS database. To determine if you have the Access version of ATS, go to the Help tab->About and the
header of the box will say “About (Access)”

It is possible that the Access database can get corrupted. Compacting the database may repair the
damage. In addition, a previous compact operation will have created a backup of the database that can
be used if the current database is corrupted beyond repair.

The system will retain three backup copies of the database in the dbbackup folder. Backing up
frequently will minimize the loss of data if the current database is corrupted beyond repair.

MS Access does not automatically remove data that is deleted by the system. Compacting the database
will remove data that has been deleted. This will reduce the size of the database file and improve
performance.

To compact the database, select Compact Database under the File menu. Then select the Compact
Database button.

The system will compact, repair, and backup the database and when complete, the Compact Database
screen will disappear.
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A user currently logged into ATS may change their password
at any time. Select Change Password from the File menu and
the screen at left appears.

Type in your current user name and password and then
select the Change password button.

Passwords must be between 5 and 10 characters long.

i Change Password =

Change Passwordlﬂ\)

Enter current User Name and Password.
Then follow the on-screen instructions.

User Name:
Password:

Change Password

Type in your new password and then select the Change Password button.

Type in your new password again. If the password matches the new password you typed earlier, the

system will save the new password and the Change Password screen will disappear.

If the password does not match the password typed in earlier, the system will state the passwords do

not match and ask if you wish to try again.

If you answer yes, the screen will be returned to the state above and you may try to type the second

password again.

Log in temporarily is a function used in order to perform some function that the current user may not

complete without the current user having to exit the

# Log In Temporarily

pg

program.

Select Log In Temporarily under the file menu. The screen
at right will appear. Enter your user name and password,
and then select the Log In button.

The banner on the main screen will turn red. As long as
someone is temporarily logged into the system these
conditions will remain.

Log In Temporarily

Enter your user name and password to temporarily login.

User Name: |

Password: |

,/_:g ' Login

When the user temporarily logged in logs out by selecting

the Log Out button, the main screen will return to normal and the original user is the current user.
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PURGE HISTORY

Enter Date Ed

If you would like to purge all history before a certain date, you can : —

. . Al tool histary records prior to this date will be purged oK
enter a specific date and then click OK. WARNING!! Be very careful Plsss erier  cats e
with this feature, when you click OK, all asset history records (F3 Tab
in the Assets icon) will be purged for good.

HANDHELD CONFIGURATION

The Handheld Configuration screen is used to select the handheld device. This version of ATS currently
supports Windows Pocket PC and CE handhelds.

To view the Handheld Configuration screen, _ =
click the File menu item and select Handheld Q Handheld Configuration
Configuration. Next, select the Brand Name of Handheld Configuration
the model you have purchased. If you did not
. . . (Other)
purchase a handheld device, you can skip this Datalogic Memor

; Datalogic Skorpio
section. Honeywell Dolphin 6100
. . . Intermec CK71 and CMN70
Pocket PC devices require Microsoft LXE M8
ActiveSync (for Windows XP) or Windows
Mobile Device Center (for Windows Vista or

newer) to communicate with ATS.

Handheld Data Folder: [\Honeywell\

Further instruction on how to use the

Handheld device and configuring it with the
Asset Tracking System will be discussed later.

IMPORTS

Each import has specific instructions included on the 5 Import Empioyees
import screen that delineates data formatting import Employees
requirements along with any special instructions you may This importl Tor NEWY employaes orly

. . It does NO t t | ds.
need. Imports are available for the following: oes NOT pte exising employes fecorcs

] »

m

The column layout of the expected import file is as follows:

*Name, *Barcode, *Facility, Log in Name, Password, Phone, Alt. Phone,

|mp0rt ASSEtS: A”OWS the import Of asset E-mail, Notes, Master Access, Tool Access, Check In / Qut Access,
Transfer Access, Reservation Access, Member Access, Employee Access,
data into the ATS System. Toal Status Access, Support Access, Maintenance Access, Status

- The file format is TXT (Tab delimited).
- The layout will be based on column position, not column headers.

Import EmployeeS' A“OWS the import Of - A column header row, if detected (based on the words BAR CODE or o

-
employee data into the Employee -

Administration table. The import even allows ‘ S

for the granting of specific access rights to
the various functions in ATS. l

Backup the database
/= (File menu) before
importing new data

': View
- Log File
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Import Employees Via Active Directory: An employee import via Active Directory can be
used. You will need to enter the LDAP Connection Settings and specifically the Path to AD.
Please note this is not a live connection with AD. In order for the system to be updated with
current AD information, you will need to press the “Import” button each time you want the
two paths to sync.

Import Locations: Allows the import of location data into the ATS system.

Please note that Sample Import File Texts can be found on our Client Center on our webiste. You can
download the appropriate file text you would like to use for data entry. Each Sample File will have
examples listed that will need to be deleted before importing. Any Column with a Red Asterisk (*) is
required. All other columns are optional. Once you have completed data entry, simply save the Excel
File as a Tab Delimited Text File. Then, go to File=>Imports, and select the appropriate import option.
Select “Find File” to find the TXT (Tab Delimited File) you just saved and press “Import File”. Once the
import is complete, you can view the “Log File” for any import Errors. The files can be found below,

Username — gigatools Password — gigatools

After logging in, click on Asset Tracking and you will see a list of Sample Import File Texts.

After logging in, select Check for Update on the Help menu. Major updates may require you to contact
GigaTrak and receive a special download. Access to the Check for Update function is only available
when the ADMIN login is used. You must have a current Support Agreement in place to download
updates.

The “About” section tells you which version of the software you currently have as well as some brief
licensing information. This area also specifies which database the software uses for your system. This
section is particularly helpful to the support and training teams when working to assist you on any
guestions you may have regarding the ATS system.
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ACCOUNT ADMINISTRATION
Account Administration is used to keep track of the account numbers that are used to purchase assets

or assign to deparments. Account numbers are not required to use ATS. This is an optional field.

E T ES 1o begin the process, select

AccountAdministration Account Administration from the

I%a Add l l/ Edit l ’% Delete

Account Number: |1000

Support menu.

To Add a new account, select the
Add button. Enter the Account
Number (required field) and a
description (optional), then select

Description |ﬁ~.ccoummg Department

s i
the Save button.
Account Number Description Active?
_ i
2000 - er To Edit an Account, select the
3000 Maintenance Department Yes Account of interest and then select
4000 Administration Department Yes

the Edit button. Modify the
information as desired. Select the
Save button to save the Account
changes.

To Delete an Account, select the

Account to be deleted and then
select the Delete button. The system will check to see if the account is tied to an asset. If so, the
system will not allow the Account to be deleted. You may inactivate the Account to prevent it from
being assigned to an asset in the future if you desire.

ASSET CONDITION ADMINISTRATION

Assets may be assigned a Condition, which indicates the usefulness of the asset. To access this process,
select Condition Administration under the Support menu. (Conditions are not a required field. The
name “Conditions” can also be changed in the Setup Options if you would like to track your Assets by
an alternate field.)
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ﬁ Aszet Condition Administration @
Asset Condition Administration
‘ |f|-..:-:z| Add ‘ 7 Edit ‘ ‘ % Delete
L
Condition: |Exce|lent
Description |I-lew or nearly new
ol o

Condition Description Active?
Good minimal damage Yes
MNeeds Repair ltem needs maintenance Yes
Poor Damage with functionality problems Yes

Each Condition has a name and
Description. In addition, a Condition may
be designated as Active or Inactive.

Condition name may be up to 20
characters and is required. This name
must be unique.

Description may be up to 80 characters
long and is not required

A Condition set as active may be assigned
to an asset; a Condition set as inactive will
not be available for assignment to an
asset. Setting a condition as “inactive”
minimizes clutter, but retains historical
information tied to each condition.

To add a new Condition, select the “add” button, enter the new Condition (name) and Description, and

click “save” button to save the new condition.

To edit an existing Condition, select the Condition to be edited and then select the Edit button. Modify
the Condition (name), Description, or Status (Active vs. Inactive). Select the Save button to save the

changed Condition.

To delete a Condition, select the Condition to be deleted and then select the Delete button. The
system will check to see if the Condition is assigned to an asset. If so, the system will not allow the
Condition to be deleted. You may inactivate the Condition to prevent it from being assigned to future

assets if you desire.

velz
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Asset Support Administration is used to create Classifications and Types. To access this process, select
Asset Support Administration under the Support menu. Asset Support Administration has two tabs:
Classification and Type; or four tabs Classification, Type, User Defined Fields, and Maintenance (Pro and
School Editions).

Classification and Type have a Parent-Child relationship. The Classification is the Category and the Type
is the Sub-Category to further narrow down information. Each company determines their own
categories. Some companies choose to get very general and only have a few Classifications (with Types
under each) and others choose to get very specific and have dozens of Classifications (with Types under
each). Every companies structure will be different.

CLASSIFICATION (F1)

The first tab is Classification. Assets will be assigned a Classification to organize them in groups.

[% Asset Support Administration (=]

Asset Support Administration

|:{..'ﬁ| Add /7 Edit % Delete O Print List

Each Classification has a name
(Classification) and Description

Classification (F1) Type (F2) User Defined Fields (F3) Maintenance (F4) (Optional) |n addition a CIaSSiﬁcation
. ’
Classification: |Cu":uter Equipment . .
may be designated as Active or
Description: |In Office Computer Equipment Not Rented

Inactive. A classification assigned as

e - active may be tied to an asset; an
Classification Description Active? inactive classification may not be tied
Cleaning Supplies Consumable Only Yes
to an asset.
Consumables Yes
Keys Yes - X . .
Micellansous Odd items Yes A classification may be set as inactive
Non-Consumable Ves
Office Funiture In Office Furniture Mot Rented Yes to reduce clutter yet retain importa nt
Rentals Customer Rentals Yes
Touls dob Tools e historical information.
Vehicles Available modes of transportation Yes

e C(Classification (name) may be up to 20 characters and is required. The Classification (name)
must be unique (i.e., no other Classifications may have the same Classification (name).
e Description may be up to 80 characters long and is not required.

To add a new Classification, select the Add button. Enter the new Classification (name) and Description
(optional). Select the Save button to save the new Classification.

To edit an existing Classification, select the Classification to be edited from the listing and then select
the Edit button. Modify the Classification (name), Description, or Status (Active vs. Inactive). Select the
Save button to save the changed Classification. Select the Cancel button to exit the Classification
change without saving the changed Classification.
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To delete a Classification, select the Classification to be deleted and then select the Delete button. The
system will check to see if the Classification is assigned to an asset. If so, the system will not allow the

Classification to be deleted. You may inactivate the Classification to prevent it from being assigned to

future assets if you desire.

To leave the process, select the [XI in the upper right corner of the screen.

TYPE

The second tab is type. Type is a sub-category of Classification. Each Classification can have several
Types. In addition to grouping assets under a Type, the Type will also set the default depreciation

/7 Asset Support Administration o]

— period for assets assigned to it.

Asset Support Administration

I E-E:H Add I \ ‘7/\ Edit ‘ I % Delete \ © Print List

Classification (F1) Type (F2) User Defined Fields (F3) Maintenance (F4) (0pt|0n3|), a I’ld DEPFECIatlon pe rIOd (Optlona|)
Classification: | Electronics Al = ,7 |n years In add|t|on, a Type may be
Type: famers - - designated as Active or Inactive. A Type set as

Description

D ti h{ . . . . .
B - i & as inactive will not be available to be assigned

Description Dep. Active? | Due Date
ST | 0 an asset.

Yes None

Yes None

Yes  Nane A type may be set as inactive to reduce

Projector Yes None

Each Type has a name (Type), Description

active may be assigned to an asset; a Type set

clutter, yet retain important historical
information.

e Type (name) may be up to 20 characters and is required. The Type (name) must be unique (i.e.,
no other Types may have the same Type (name)).

e Description may be up to 80 characters long and is not required.

e Depreciation may be up to 255 years and is not required.

To add a new Type, select the Add button. Select the appropriate Classification for the new Type.
Enter the new Type (name), Description, and depreciation period. Select the Save button to save the
new Type.

To edit an existing Type, select the Type to be edited and then select the Edit button. Modify the Type
(name), Description, Depreciation, or Status (Active vs. Inactive). Select the Save button to save the
changed Type.

To delete a type, select the Type to be deleted and then select the Delete button. The system will
check to see if the Type is assigned to an asset. If so, the system will not allow the Type to be deleted.
You may inactivate the type to prevent it from being assigned to future assets if you desire.

To leave the process, select the [XI in the upper right corner of the screen.
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Default Due Dates (Only available in the School Edition) — You can set Default Due Dates per Type of
Asset. Therefore, when an Asset is checked out and that Type has a default due date, an automatic due
date will be set. *Default Due Dates only work when checking items out from the PC application.

USER DEFINED FIELDS (PRO AND SCHOOL EDITION ONLY)

The third tab is for User Defined Fields. Fields can be added specific to an asset “Type”. When new
assets are added to the system, the added fields are displayed in the Asset Information screen for user
entry. User Defined Fields allow you to track extra information about certain “Types” of Assets. These
fields are created by you.

After selecting the appropriate Classification and Type for the asset, a listing of the current User
Defined Fields is displayed. Each field has a name and may be designated as Active or Inactive. Setting

[} Ak Support Admiistration E= 3 User Defined Field to inactive does NOT
Asset Support Administration

remove the data already recorded for any
S o e K oot € Frin L asset of that type. It will not be displayed on

Classification (F1) Type (F2) User Defined Fields (F3) Maintenance (F4)

Classification: | Computer Equipment -
Type: | Desktop PC hd

the Asset Information screen. Returning the
asset to active will restore prior data for each

Field Name: [Frocessar asset of that type.
- = . The Field Name may be up to 50
Fleld tame L= characters and is required.
vy o . A Field Name set as active will be
e assigned to each asset of that Type.
. A Field Name set as inactive will not be
available.

MAINTENANCE (PRO AND SCHOOL EDITIONS ONLY)

The fourth tab is Maintenance. Each “Type” of asset may be assigned a group of specific Maintenance
items with a preset interval in months for required performance. In addition, a “Repair” maintenance
item may automatically be inserted when a new “Type” is created. This is created in Setup Options on
the F2 tab.
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Each maintenance item has a Description and Special Instructions. In addition, a maintenance item

may be designated as Active or Inactive. Setting a Maintenance item to inactive may be useful to

reduce clutter when assigning Maintenance item to assets, yet it remains in the database for historical

P( Asset Support Administration

E

Asset Support Administration

‘ (ID Print List ‘

|
‘I%-El Add ‘ ‘// Edi// % Delete
{
Classification (F1) Type (F2) User Defined Fields (F3)
Classification: | Electronics -
Type: | Computer -

Maintenance (F4)

Maintenance Description: |Repair

Special Instructions

Interval: (0

Manths

-

Maintenance Description
Repair

Run Diagnostics Scan
Update Software

Special Instructions

Interval Active?

Vs |

2
2

Yes
Yes

purposes.
° The Maintenance Description may be
up to 50 characters and is required. The
Description must be unique (i.e., no other
Description may be the same).

° Special Instructions may be up to 255
characters long and is not required.

° A Maintenance item set as active may
be assigned to an asset of that type.

. A Maintenance item set as inactive will
not be available.

To add a new Maintenance Item, select the
Add button. Enter the new Maintenance
Description. Enter any Special Instructions.
Select the Save button to save the new
Maintenance Item.

To edit an existing Maintenance Item, select

the Maintenance Item to be edited and then select the Edit button. Modify the Maintenance
Description, Special Instructions or Status (Active vs. Inactive). Select the Save button to save the

changed Maintenance Item.

To delete a Maintenance Item, select the Maintenance Item to be deleted and then select the Delete
button. The system will check to see if the Maintenance Item is assigned to an asset. If so, the system
will not allow the Maintenance Item to be deleted. You may inactivate the Maintenance ltem to
prevent it from being assigned to future assets.

To leave the process, select the [XI in the upper right corner of the screen.
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Facilities are the upper hierarchy of locations (Parent/Child relationship). In other words, locations are

tied to a facility. Due to this structure, at least one facility is required by the system.

To begin the process, select Facility Administration from the Support menu.

Facility information consists of:
Unique Name (Required)- up to 40 characters
Address - up to 40 characters long, but is not
required.
City- up to 40 characters long, but is not required.
State-up to 2 characters long, but is not required.
Zip Code- up to 10 characters long, but is not
required.
Notes-up to 255 characters long, but is not required

To Add a new facility, select the Add button. Enter the
information as desired. Select the Save button to save the
new Facility. Select the Cancel button to exit the Facility
addition without saving the new Facility.

To Edit a Facility, select the Facility of interest and then
select the Edit button. Modify the information as desired.

Lﬂ Facility Administration @

Facility Administration

‘ rﬂ Save ‘@Canc&l
LET ERLACME Central Warehouse|

Address:

442 Central Circle

City: |Everywhere

State: (Wi
Zip: |55444

Motes:

Status

@ Active " Inactive

Select the Save button to save the Facility changes. Select the Cancel button to exit the Facility addition
without saving the Facility changes. In either case the main screen, shown at the beginning of this

section will appear. If the Facility was saved, the changed Facility will appear on the Facility list.

To delete a Facility, select the Facility to be deleted and then select the Delete button. The system will
check to see if a location is tied to the Facility. If so, the system will not allow the Facility to be deleted.
You may inactivate the Facility to prevent a location from being assigned to it in the future if you desire.

To leave the process, select the [XI in the upper right corner of the screen.
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' Funding Source Administration

[

Funding Source Administration is used to keep track of the agency

Funding Source Administration

that provided the asset or the budget used to purchase. The

Funding Source is not required to use ATS and can be renamed in ['fl“}j Add ] ‘.-/ Fat ‘ ‘% Detete
the Setup Options. R

‘(:acwla\ Budget
To begin the process, select Funding Source Administration from

o [

the Support Menu. The screen will appear. — .

Capilal Budget __[Yes
Activities available for Funding Source are: ety e

-Adding new Funding Source
-Editing existing Funding Source
-Deleting Funding Source

Adding a New Funding Source:

To add a new Funding Source, select the Add button. Enter the description, then select the Save button.
Select the cancel button to exit the Funding Source addition without saving the new Funding Source.

Editing an Existing Funding Source:

To Edit a Funding Source, select the Funding Source of interest and then select the Edit button. Modify
the information as desired. Select the save button to Save the Funding Source changes. Select the
Cancel button to exit the Funding Source addition without saving the changes.

Deleting an Existing Funding Source:

To delete a Funding Source, select the Funding Source to be deleted and then select the Delete button.
The system will check to see if the Funding Source is tied to an asset. If so, the system will not allow the
Funding Source to be deleted. You may inactivate the Funding Source to prevent it from being assigned
to an asset in the future if you desire.

To leave the process, select the [XI in the upper right corner of the screen.

Location Administration is used to manage the locations to which assets may be assigned. It displays all
the locations that exist in the system that are tied to the facility selected.

To add a new Location, select the Facility to which it is to be added and then select the Add button.
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TRy T—— = Enter the location information as desired:

U e e Facility - defaults to the facility selected on
e | e | § vaee the main form but may be changed.
oY xport To File ,’;.- Change Responsible m .
[ S ) | Location - may be up to 50 characters and is
Facility: ‘Mam Office j . . .

Location Barcode Responsible Individual | Storage? | Active? requred. MUSt be Unlque tO eaCh Iocatlon'

e — — 1 i —

Office 102 Loo2 User, Admin - No Yes

oFes 22 Lone TR " Barcode - may be up to 20 characters long

Storage L005 User, Admin - Yes Yes . .
and is required. A barcode for an asset,
location, or employee cannot be the same.
Checkout/Usage Location -location that
assets can be checked out to.
Storage Location - location used for storage
rather than usage. (EVERY ASSET MUST
HAVE A STORAGE LOCATION (unless you are
on relocate mode))

el Sl EX Responsible Individual - employee that is
Location Adninisiration responsible for the assets at the location.
This is not required. If the responsible
o 3 individual is not in the system, you may go

Location: ’M— directly to the Employee Administration

| process by selecting the Add New Employee
Barcode: (L001
& Checkout/Usage Location bUtton-

C Storage Locaton Notes - may be up to 255 characters long
Respansible Individual and |S nOt requ'red.

Noes: : To edit a Location, select the Facility
containing the Location, select the Location

of interest and then select the Edit button.
Modify the information as desired. Select
the Save button to save the Location

Status

® Active € Inactive

changes.

Every company will have a different structure for your Facilities and Locations. You can choose to get
very general (i.e. ABC Company (Facility Name) = Warehouse (Storage Location Name)) with just a few
Locations or very specific (i.e. ABC Company (Facility Name) = Aisle 1, Aisle 2, Shelf A, Shelf B (Multiple
Storage Location Names)). Every Asset in the system will have a desighated Storage Location; where the
Asset goes when NOT in use. During checkout, an Asset goes to an Employee or Checkout Location. If
you are only checking out to Employees, you may have NO ‘Checkout Locations’ listed.

To delete a Location, select the Location to be deleted and then select the Delete button. The system
will check to see if an asset is tied to the location or the Location is being used in a history record. If so,
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the system will not allow the Location to be deleted. You may inactivate the Location to prevent an
asset from being assigned to the Location in the future if you desire.

EXPORT LIST TO FILE

This button will export information for the displayed locations to a tab delimited text file.

CHANGE RESPONSIBLE INDIVIDUAL

Change Responsible Individual will change the responsible individual for all selected locations on the
screen. Display and select the locations that you want to change. To select multiple locations, do one
of the following:

e Dragthe mouse over the locations desired while holding down the left mouse button.

e Select the first location by left clicking with the mouse. Select the last location in a range by
holding down the Shift key and then left clicking on the last location. All locations in between
will be selected.

e Hold down the Control (Ctrl) key and select the locations you wish to change by left clicking on
each one with the mouse.

After the locations are selected, click the Change Responsible Individual button. A screen will appear
where you can select a new Employee. Select the new Employee and click the OK button.

PRINT BARCODE LIST

Print Barcode List will print a list of the displayed location barcodes that can be used for scanning.
When the Print Barcode List button is selected, a pop-up window will appear where you can set the
barcode row height. This allows you to control the space between barcodes on the list. The minimum
row height is 0.5 inch.

PRINT LOCATION LABEL

To print a Location label, select the location(s) to be printed and then select the Print Label button. If a
label printer has been selected and if a default location label has been designated (see Label Designer
in this manual), the label(s) will be printed.

For label printing, multiple locations may be selected. To select multiple locations, do one of the
following:
e Dragthe mouse over the locations desired while holding down the left mouse button.
e Select the first location by left clicking with the mouse. Select the last location in a range by
holding down the Shift key and then left clicking on the last location. All locations in between
will be selected.

Hold down the Control (Ctrl) key and select the locations you wish to print by left clicking on each one
with the mouse.
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The Maintenance/Repair Provider Screen allows you to standardize the name of each provider who
services your equipment. You can add new provider names, edit existing names and delete providers
not used for maintenance.

To start the process, select Maintenance/Repair Provider Administration from the Support menu.
To add a new provider, select the Add button.

Provider Information consists of:

" Maintenance / Repair Provider Administration [m5a] Unique Name (Required)___up to 50 CharaCterS
Maintenance / Repair Provider Administration

)
%—] Add /" Edit % Delete

Provider

Address---up to 100 characters, but is not required. If an
address is entered, it will appear on Maintenance Request

Report.
Provider Name Active?
In House (ABC Campany) Yeu City---up to 40 characters, but is not required.

The Everything Guys Yes

State---up to 2 characters long, but is not required.
Zip---up to 10 characters long, but is not required.
Contact---up to 100 characters long, but is not required.
Notes---up to 255 characters long, but is not required.

Enter the information as desired. Select the Save button to save
the new provider. Select the cancel button to exit without
saving.

To edit a provider, select the provider of interest and then select the edit button. Modify the
information as desired. Select the save button to save the provider changes. Select the cancel button to
exit without saving the changes.

To delete a provider, select the provider to be deleted and then select the delete button. The system
will check to see if an asset maintenance record is tied to the provider. If so, the system will not allow
the provider to be deleted. You may inactivate the provider to prevent its use in the future if you
desire.

To leave the process, select the in the upper right corner of the screen.

The Label Designer is used to design labels for the various processes in the system that print barcodes.
There are three process which print labels: assets, locations, and employees.

These processes can be selected in the Design Type section of the form, located in the upper left
corner.

To design a label, first select the design type.

velz ATS USER MANUAL 30



The data source list will contain the possible fields that may be included in the label.

{ Label Designer

x

Label Designer ABC Company
Design Type Current Label Designs TN The Current Label Design
@ Asset PPC Al e
® Ema Redeening 5| list will contain labels that
" Location Sample Asset Label
Test - have already been created
Save As Defaul Asset Label
R for the design type. The list
T -] |o|@ currently contains a sample
el 12 Readr asset label. When one of
[™ Wrap Text? [ Center Text?
Data Source these labels is selected, the
o - Label Size b h ich ill d |
.:zcsuet:rgalﬁgnrgzer Aa e Width  Height OX On t e rlg t Wi ISp ay
i | Ewmewe] T the label design, as
Orientation Mode . .
[ABC Company $ Delete Element o Pur‘”;h indicated above for the
@ Design " Print View
New Delete i Save an Save Design LdCncscope
Design e Design Design [é‘" Ao Label Printer WPTSNICOLEG pracessandtechnology local\Brother HL2140 Sample asset label.

To create a new label, select the Design type and then select New Design button. Set the label size
(width and height in inches). Set the label orientation (Portrait or Landscape). For Portrait, the height is
vertical on the screen. For Landscape, the height is horizontal on the screen.

There are 6 different elements that may be placed on the label. They are (left to right): text, barcode,
horizontal line, vertical line, box, and a graphic.

ADDING A TEXT ELEMENT

Select the Text (T) button in the Element Options panel. Select (Label Caption only) in the Data Source
box, and type a label caption in the Label Caption textbox. You can select Wrap Text or Center. To set
the font style and size, click the Font button. Click the Add to Label button. The text element will
appear in the upper left corner of the label design. Drag it to the desired position on the label.

To edit the text caption or font after a text element has been placed in a label design, right click on the
element and choose the option desired.

ADDING A DATABASE FIELD TEXT ELEMENT

In the Data Source box, select the desired database field. You can select Wrap Text or Center. To set
the font style and size, click the Font button. Click the Add to Label button. A sample of the data will
appear in the upper left corner of the label design. Drag it to the desired position on the label. When
the label is printed, the actual data for that field will be printed on the label.

To edit the text caption or font after a database field text element has been placed in a label design,
right click on the element and choose the option desired.
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ADDING A BARCODE ELEMENT

Select the Barcode button in the Element Options panel. Select (Label Caption only) in the Data Source
box, and type a label caption in the Label Caption textbox. You can select Center. Select the barcode
font and size desired. Click the Add to Label button. The text will be added to the label in the barcode
font. Drag it to the desired position on the label.

If a database field is needed as a barcode, select the field from the Data Source box, and add it to the
label. When the label is printed, the actual data for that field will be printed on the label as a barcode.

ADDING A HORIZONTAL LINE ELEMENT

Select the Horizontal Line button in the Element Options panel. Click the Add to Label button. A
horizontal line segment will be added to the label design in the upper left-hand corner. Drag it to the
desired position on the label. To change the size of the line, place the mouse cursor over the right end
of the line. When the cursor changes to a double arrow, click and drag the endpoint to the desired
length.

ADDING A VERTICAL LINE ELEMENT

Select the Vertical Line button in the Element Options panel. Click the Add to Label button. A vertical
line segment will be added to the label design in the upper left-hand corner of the label. Drag it to the
desired position on the label. To change the size of the line, place the mouse cursor over the bottom of
the line. When the cursor changes to a double arrow, click and drag the endpoint to the desired length.

ADDING A BOX ELEMENT

Select the Box button in the Element Options panel. Click the Add to Label button. A box will be added
to the label design in the upper left-hand corner. Drag it to the desired position on the label. To
change the size of the box, place the mouse cursor over the lower right-hand corner of the box. When
the cursor changes to a double arrow, click and drag the endpoint to the desired size.

ADDING A GRAPHIC ELEMENT

Select the Graphic button in the Element Options panel. Click the Find Graphic File button to find a file
on your computer to place on the label. File types supported are bmp, gif, jpg, wmf, and ico. Click the
Add to Label button. The graphic will be added to the label design in the upper left-hand corner. Drag
it to the desired position on the label.

Graphic elements are resizable. Save the label design before attempting to resize a graphic element.
Right click on the graphic in the label and select Resize Graphic. A Resize Graphic box will appear above
the Label Size box. Enter the desired Height and Width (in inches) and click the OK button. It may be
possible to enter a size that causes the graphic to disappear from the label design. If this happens,
select a different label design. When prompted to save changes, respond NO to the prompt. Then go
back to the label design and try again.
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DELETING A LABEL ELEMENT

Select the element to be deleted from the label design. Click the Delete Element button, or press the
Delete key on the keyboard. Elements can also be deleted by right-clicking on the element and
selecting Delete from the popup menu.

DELETING A LABEL DESIGN

To delete an entire label design, select the design from the Current Label Designs list. Click the Delete
Design button at the bottom of the screen.

SAVE AN EXISTING DESIGN AS A NEW DESIGN

Time may be saved by copying an existing label design and modifying it. Select the design from the
Current Label Designs list, and click the Save Design As button at the bottom of the screen. Enter a new
design name and click the OK button. Design names must be unique.

VIEWING/PRINTING A LABEL

The work space on the right-hand side of the screen provides a feel for how your label will print. If you
need to view exactly how your label will print, click on the View button with the Mode setting set to
Design. An exact replica of the label will appear. To print the label on your label printer, change the
Mode setting to Print, enter the number of labels you want to print and click the Print button.

To save a label design as default for a specified process, select the Design Type (process), and select the
label design from the Current Label Designs list. Then select the Save as Default button.

When a label is set as the default label, the word "Default" will appear after the label design.

To leave the process, select the [XI in the upper right corner of the form.
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The Label Setup screen allows the printing of barcode labels in sequence. This feature is only available
for the Asset Design Type. This allows printing of asset barcode labels that can then be attached to
assets, and entered on the Asset Information screen.

— =™ Any Asset Label design can be
Label Setup III\IIIIIIELy:! .
— e chosen, it does not have to be

L the “Default” design. The label
o design must contain the barcode

[ SaveAsDefaulAssetlabel | . . .
PrintLabel | design element or it will not

Sequence

print. Note that if the label
design contains an asset
description, the description will

Width  Height be blank. They have not yet
o

been assigned to an asset.

Mode
=

- & Design ¢ Print View

Label Printer- HP Color LaserJet Pra MFP M476 PCL &

On the Label Setup screen, select

v2.4

the Asset Design Type, then
select the Print Label Sequence button. The screen below will be displayed.

A three (3) character prefix can be entered if desired. The Start Number will initially start at 00000001
but can be changed to any number desired (up to 8 characters). Enter the number of labels to print in
the How Many box and select the Start button.

The system will check the barcodes already assigned to assets in the database to be sure that the

barcode to be printed is unique. If it is unique, the label will print. If it is not unique, the number will
be skipped, and the next number in the sequence will be checked. If the number of characters in the
Start Number is incremented beyond 8 characters, a message will be displayed and printing will stop.

After printing starts, a Cancel button will appear. Selecting the cancel button will stop the printing
process. Pressing the Esc key on the keyboard will also stop printing.

The prefix and the last barcode number printed will be saved in the database. These values will then
appear the next time the Print Label Sequence function is used. The Start Number will automatically be
increased to the next value.

To exit the Print Label Sequence function, select the Close button.
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The Asset Management process is started by selecting the Assets button on the main toolbar, which
displays the screen below:

Four tabs are displayed (3 tabs on Basic Edition). The first is the “Find” tab, which is used to view assets
and print lists of assets. The tab is controlled by sections on the upper part of the form, allowing you to
filter and view those items by:

=@

emired ° | e Facility
Bl 2lAs FAE i
J s Dol a e Location
' e e e e Funding Source
e Account
e Condition
e Specific Search Field
e (Classification
e Type
e User Defined Fields (Pro &

5 Asus - 24°LED HO Motar - Bisck VoaueaE Chicago .
e School Editions)
- = = e e Status

e e e —— e Other

Several key aspects are available on the form. As an example, selecting the Reset button will return all
selections to All. In addition, the Asset list can be sorted by one of its columns by clicking on the
heading of that column. A second click will reverse the sort order of the items in the listing.

SEARCH FIELD

Groups of assets can also be displayed by typing words in the Search Description box, and then
selecting the Extract button. For example, if you type in the word “chair” into the box and click extract,
only the assets that have the word “chair” in their description will be displayed. If a location is also
selected, only assets that are located at the particular location and have the word “chair” in the
description will be displayed.

ADD TO LIST

The Add to List button can be used to build a custom list of assets. When selected, it will appear to
remain depressed. When in this mode, assets that are extracted will be added to the list of assets
already shown on the screen, rather than clearing the screen first. You can continue to change the
selection filters and extract the assets you need to build your list. The list can then be printed or
exported. Clicking the Add to List button a second time will return the Extract Data function to its
normal mode.
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PRINT LIST

To print the Assets in the list, select the Print List button. A report is displayed and if the default printer
is set, the Assets displayed on the screen will be printed when Print is selected. You may also save it as
a PDF or Email the report directly.

PRINT BARCODE LIST

Print Barcode List will print a list of the displayed asset barcodes that can be used for scanning. The list
will include the Barcode number, Barcode, Description, Product Number, and Serial Number. When the
Print Barcode List button is selected, a pop-up window will appear where you can set the barcode row
height. This allows you to control the space between barcodes on the list. The minimum row height is
0.5 inch.

EXPORT LIST TO FILE

Export List to File will export information for the displayed assets to a tab delimited text file.

ASSET IMAGE

If an image is assigned to an asset, a thumbnail picture will be displayed in the Description column of
the grid. The thumbnail display can be turned on or off by right-clicking in the grid and selecting “Show
Thumbnail Images” in the pop-up menu. A larger view of the image can be displayed by selecting “View
Image” from the pop-up menu.

Selecting an Asset and then selecting the Asset Information tab, or double-clicking on an Asset will
bring up the Asset Information screen:

Asset information fields that are BOLD are required. The available asset information is:

:: 2 = "j‘ e Classification is a method of grouping
= — - = Assets
s BE - e Type is a subset of Classification and a
= _— second method of grouping Assets
- e Description is up to 80 characters
“““ D = describing the Asset

Lo oo s

Samtese, € i Lo ysean s ton
- Tl

e Facility is the building in which the
Asset is located

e Storage Location is the default storage
location for the Asset

e In Service Date is the date the asset was put into service (defaults to current date)

e Barcode is the barcode that identifies the Asset. You must enter the first asset’s barcode number
manually in a format that all barcodes will use (i.e. AO0O001). The system will then automatically
increment the numerical portion of the barcode number one at a time. If you are using pre-printed

barcodes, enter the number seen on the barcode.
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e Funding Source is the agency that provided the Asset or the Budget used to purchase

e Asset Number is the unique permanent number given to an item for tracking. An asset number is
usually engraved on larger, more expensive items.

e Condition is the physical condition of the Asset. Condition does not apply to binned items.

e Model is the model number of the Asset

e Serial Number is the Serial Number of the Asset

e Account is the account number used to purchase the Asset or to assign to departments.

e Status. An Active asset may be checked out, A Retired asset may not be checked out.

PRIMARY DATA SUB-TAB

e Note is up to 255 characters of information about the Asset
e Binned item is used for small items that cannot be individually bar coded. Binned Assets can be
either Non-Consumable (you expect these Assets back; ie Folding Chairs) or Consumable (the
moment these Assets are checked-out, they are consumed and you will not get them back; ie Paper
Towel Rolls). To learn more about how to Enter a Binned Asset, please see below.
o Check Out determines whether an asset is checked out or not. If it is checked out, the following
information will be available (This section is information only and cannot be Edited from this screen)
o By: User to whom the asset is checked out
o Location: location to which the asset is checked out
o Due Date: date the asset is due to be checked in

PURCHASE / WARR. SUB-TAB

e Purchased From allows entry of general supplier information

e  Warrant Expiration Date tracks when a warranty period expires

e Depreciation period in years (does not apply to bin items)

o NOTE: fields relating to Depreciation will not be visible unless the “Show Depreciation”
checkbox is checked on the Setup Options screen.

e Depreciation Type. The system will calculate depreciation based on five methods: Standard Straight
Line, MACRS Half-Year, MACRS Mid-Quarter, MACRS Double Declining Half Year, and MACRS Double
Declining Mid Quarter

o MACRS means Modified Accelerated Cost Recovery System

e Original Value is the cost basis for depreciating the Asset (Purchase Price)

e Salvage Value is the remaining value of the asset after it has been fully depreciated

e Current Value is the current depreciated value of the Asset (Automatically calculated based off In-
Service date)

e Date for Current Value is the date used to calculate the current value (will always be the end of the
current month)

e Miscellaneous is a user definable field that can be used as desired (Only in Pro and School Editions)
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IMAGES & DOCS SUB-TAB

Asset Image is the path to a file that contains a picture of the asset. If the image information is entered
and a file is at the proper location, the picture will be displayed in the area to the right of the sub-tab
section. Double clicking on the image will display a full sized image of the picture. In addition, linked
documents, PDF, URLs, and other related files can be assigned to the Asset. Images and Documents
must already be saved in the respective folder of your ATS file location. You can find these folders by
right-clicking on your ATS icon and clicking on “Open File Location”. Here you will find the respective
folders where you will need to save any Images or Documentation to attach on the F2 tab. Once files
have been saved, simply click on the ellipses box to attach an image to an Asset.

Primary Data Purchase / Warranty Images & Docs User Defined Data
Asset Image: [DELL 19 FLAT PANEL LCD.JPG @
View Add File Add URL Attached Images & Documents Remove

To attach a document, click on “Add File” and choose the document from the folder you would like to
attach. Attach a website by clicking on “Add URL” and entering a web address. To open a file below,
simple double click on the file name.

USER DEFINED DATA SUB-TAB (PRO AND SCHOOL EDITIONS ONLY)

The fourth tab is for entry of User Defined Data. User Defined Fields allow you to track extra
information about certain “Types” of Assets. The User Defined Field names are entered per “Type” of
Asset in ‘Asset Support Administration’. When new assets are added to the system, the added fields
are displayed here for user entry. You cannot add in new field names from this screen, only the data
associated with each field. Double click on the data line you would like to enter data, type in your data,
tab over to default to today’s date for “Date Entered” (or manually change) and press Save. User
Defined Fields can then be searched upon from the F1 screen by first choosing a Type, then User
Defined Field name, and finally entering the “User Data” you would like to search upon.

Primary Data Purchase / Warranty Images & Docs User Defined Data
Field Name Data Date Entered
Processar: Intel Duo 2 091152017
Software Version: Windows 10 09112017
Storage Capacity: 128 GB 091152017
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ADDING A NEW ASSET

To Add a new Asset, select the Add button. All information is cleared and the Save and Cancel buttons
appear.

Start by choosing an option

el Assets
Find Asset (F1) Asset Information (F2) Asset History (F3)

from each drop-down

Asset Information

Classification: | =] sacose: oo [jl| P menu of the Asset you
e[ =] AssetNumber
Desmpﬁnmli e I— would like to enter. Scan
Model Number: -
T — q - or manually enter a
Facilt:[ C] FudingSoues:| 5] . 4o

e E— P @ o Barcode number. Each
In Service Date: [09/11/2017 | ...
barcode number must be

Primary Data Purchase / Warranty | Images & Docs User Defined Data

Note. Binned ltem: [

unique. Once you have
Image

Unassigned saved your first record, the

system will automatically
increment the barcode in

sequential order when
adding a new Asset. If you would like to change the barcode, just Edit the Barcode field as desired.
Enter all required information (bold labels). Enter the non-required information if desired. Save the
Asset by selecting the Save button. The screen will return to the original state with the new Asset
information.

Cancel the process without saving by selecting the Cancel button. The screen will return to the original
state with the information displayed that was present prior to selecting the Add button.

EDITING AN EXISTING ASSET

To Edit an existing Asset, select the Edit button. The Save and Cancel buttons appear.

Change the Asset's information as desired. Information with bold labels is required. Save the Asset by
selecting the Save button. The screen will return to the original state with the changed Asset
information.

Cancel the process without saving by selecting the Cancel button. The screen will return to the original
state with the Asset information unchanged.

COPYING AN EXISTING ASSET’S INFORMATION TO A NEW ASSET

This is one of the most helpful features when multiples of the same type of asset needs to be entered.
To Copy an existing asset's information to use in creating a new asset, select the Copy button. The
majority of data is copied to a new record. The exception is that the barcode number, serial number
and checkout information is cleared and the Save and Cancel buttons appear.

The system will automatically generate a unique barcode for the asset. If this barcode is unacceptable,
it can be typed over by the user. The barcode entry must be unique. A barcode for an asset, location,
or employee cannot be the same. Change the asset's information as desired and add the new barcode.
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Save the Asset by selecting the Save button, the screen will return to the original state with the new
Asset information.

Please note that the Copy function copies over In-Service Date, all Depreciation, as well as
Images/Documentation. If any of this information needs to be changed, you will need to manually
change it.

Cancel the process without saving by selecting the Cancel button. The screen will return to the original
state with the Asset information unchanged.

To Delete an existing Asset, select the Delete button. After asking if you are sure, the system will delete
the Asset.

ADDING IN A BINNED ASSET

A Binned Asset is an item that you do not want to barcode individually but you would still like to keep
track of. Therefore, there is one barcode associated with the whole lot of same items. Binned Assets
can be Consumable (you do not expect to get them back because they are consumed the moment they
are checked out; i.e. Paper Towels) or Non-Consumable (you do expect to get them back; ie. Folding
Chairs). To Add in a new Binned Asset, go to the F2 tab and Press “Add”. You will enter all required
information just like any other Asset. Some customers like to organize their Binned ltems by creating
new Classes and Types (i.e. Binned/Consumable). Next, before saving, you MUST check the box
marked “Binned ltem” under the Primary Data Tab and choose whether the item is Consumable or
not. If you forget to check the box, and save the Asset, you will be unable to Edit the item to a Binned
Asset. You will need to delete the item and start over. Next, enter your Storage Bin Quantity and Re-
order Point (the point in which you would like to be notified when stock is getting low). Save the Asset.
Now, during check-out, when a Binned Item Barcode is scanned, the user will be prompted for the
Quantity they are checking out. When you have purchased and received in more Binned Items, click on
the “Receive Bin Items” icon and enter the quantity you received. Your Storage Bin Qty will update.

lg:! Assets

Find Asset (F1) Asset Information (F2) Asset Hist
Asset Information
Classification: |aned j Barcode: ‘RU!H |||||||I‘| Print
Label
Type: |Cun5umab|e j Asset Number: ‘
Description: |1 Roll Paper Towel Condition ‘ J &
Model Number: ‘ &
Serial Number: ‘ H
T Save
Facility: |ACME Central Warehouse j Funding Source: ‘Adm”‘”stra‘ivg Budget j d
Storage
Lucali{g)n: |Warehuuse j Account: ‘Engmeermg 15000 j @ Cancel
In Service Date: |09/11/2017
Primary Data Purchase / Warranty Images & Docs User Defined Data

Binned tem: ¥ Consumable: ¢ No & Yes

Storage Bin Qty: |155 Reorder Point- 25

Note:
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If a Binned Item is Non-Consumable, you will easily be able to see a list of checkout quantities at each

Location/Employee.

Purchase / Warranty

Binned ltem: Iv

Storage Bin Qty: [153 Rearder Point: |25

Images & Docs

Consumable:

* Mo

User Defined Data

" Yes

Checked Qut to Emp / Loc

Tatal Out:
Engineering Dept (Acme Campus)
Davis, Mary
Smith, John

Qty Out

25
10
10
4]

ASSET HISTORY

Selecting an asset and then selecting the Asset History tab (F3) will bring up the Asset History screen

G Assets ==
Find Asset (F1) Assel Information (F2) Asset History (F3) Assel Maintenance (F4)
Asset History
Description: [Allin One Scanner, Printer. Copier ‘ Serial Number: (1563258
From: [TEHEIANE |... To: [osrti2017 |, (j Print List
Type From Person Location Condiion | Bin Qty Transaction By Check Out Note -

03/11/2017 01:27 PM_Checked in Smith, John Aisle 1 Good User, Admin

09/11/2017 0126 P S1at change: Breken to Aisle 1 User, Admin

09/11/2017 01:26 PM_Checked out Aisle 1 Smith, John Goad User, Admin

03/11/2017 01:26 PM Checked in English Dept Aisle 1 Good User, Admin

09/44/2017 01:26 PM_Checked out Aisle 1 English Dept Good User, Admin gf;:if for Research

09/11/2017 01:25 PM Checked in - Broken  White, Brady Aisle 1 Good User, Admin

09/11/2017 01:25 PM  Checked out Aisle 1 White, Brady Good User, Admin

09/11/2017 01:25 PM  Checked in Fern Town Hall Aisle 1 Good User, Admin

09/11/2017 01:25 PM_Checked out Aisle 1 Fern Town Hal Good User, Admin

09/11/2017 01:24 PM Ea'gcg"ds i T Aisle 1 User, Admin

03/11/2017 01:24 PM Checked in Frank, Amanda Aisle 1 Good User, Admin

09/11/2017 01:24 PM Checked out Smith, John Frank, Amanda Good User, Admin

03/05/2017 02:04 P Auit - Found Smith, John Smith, John Good User, Admin

08/04/2017 12:15 PM Checked out Chicago Smith, John Good User, Admin

05/23/2017 04:11PM_ Checked out Aisle 1 Chicago Good User, Admin

05/0412017 01:45 PM| Checked in Chicago Aisle 1 Good User, Admin

05/04/2017 01:45 PM Checked out Aisle 1 Chicago Good User, Admin

The screen displays the history of the selected asset for the date range selected. The system defaults
the date range to the last 12 months. Change one of the dates and select the Enter key or select a new

date with one of the calendar controls and the list will change to reflect the new date range. The F3 tab
is information only and data cannot be changed here. All transactions including check Ins/Outs, Audits,
Status Changes, Storage Location Changes, and Barcode Changes will be listed as a line item here.

To print the history displayed on the screen, select the Print List button.

To remove all history records for the selected asset prior to a specified date, enter the date in the Date

text box and then select the Purge button. All history records for the asset prior to the date specified

will be deleted. The purge button is only available if the “Allow Delete Asset & Purge History” checkbox

is checked on the Setup Options screen.
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To leave the process, select the [X] in the upper right corner of the screen.

Selecting an asset and then selecting the Asset Maintenance tab (F4) will bring up the Maintenance
Items/History screen below.

The first tab lists the Maintenance/Repair Types set up on the Asset Support Administration Screen (per
Type of Asset). This screen allows us to record Maintenance on individual Assets. You cannot Add in
new Maintenance/Repair Types from this screen. That must be done in Asset Support Administration.

] Assets =)
Find Asset (F1) Asset Information (F2) Asset History (F3) Asset Maintenance (F4)
Asset Maintenance
[at100 | B300 o
Description: [All in One Scanner, Printer, Copier ‘ Serial Number: [415632AA8
Start Date: Notes:
. J~. Print Maint.
Repair Type: O e
Repair Provider: | | Condition: | | B Print Maint
Completed Date: Repair Cost O Request
Maintenance Items Maintenance History
Blue Text: dueinnext5days  Red Text: Past due mai
Maintenance / Repair Type Special Instructions ('ﬂ‘rf':;’.f’s', Last Done | Next Due
06/05/201
[ Ink Check/Change Check ink levels and change out or order more if getting low 9 09/05/2017 H
[ Repair 0
171
0 Update 6 0572017 1" ‘;2”‘

RECORD A NEW MAINTENANCE RECORD (PRO AND SCHOOL EDITIONS ONLY)

To record a new Maintenance record, double-click the line item of the Repair Type. The selected
Maintenance/Repair Type and Start Date (today’s date) will appear. Choose a repair Provider from the
drop-down menu and then save. The system will offer to print a Maintenance Request form to send
with the item to the provier. An “open” maintenance record is then inserted into history. The F2 tab for
this Asset will state the status as “Out for Maintenance”.
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e Assets
Find Asset (F1)
Asset Maintenance

Barcode: [AT100 |

Description: [All in One Scanner, Printer, Capier ‘

Asset Information (F2)

Model Number. (B300

45632AAB E Save
@ conen

Serial Number:

Asset History (F3)

Asset Maintenance (F4)

Start Date: (09/11/2017 .. Notes: Repaired broken tray table]
Repair Type: |Repair =
Repair Provider: [In House (ABC Company) - Condition: | Good ~|
Completed Date: [09/11/2017 ... Repir Cost: [65.00
Maintenance hems Maintenance History
Maintenance / Repair Type Provider Notes Employee Stant Date | “OPIetEd Condition Cost A

(WRepair __________[InHouse (ABC Company) | JUsecAdmn 0907 | leeed | 90000 |
[ Ink Check/Change The Everything Guys User, Admin 09/01/2017  09/05/2017 Good 0.00

[J Ink Check/Change In House (ABC Company) User, Admin 06/02/2017  06/02/2017 Good 10.00

[J Repair In House (ABC Company)  Replaced all 3 User, Admin 06/02/2017  06/02/2017 Good 25.00

0 Update In Houss (ABC Company)  Testing User, Admin UEATI0NT  QSMTI2UMT Good 0.00

[ Ink Check/Change In House (ABC Company)  Testing User, Admin 05/17/2017  05/17/2017 Good 10.00

[J Ink Check/Change In House (ABC Company)  Take a picture User, Admin 05/10/2017  05/10/2017 Good 15.00

[ Ink Check/Change In House (ABC Company)  Testing User, Admin 05/04/2017  05/04/2017 Good 10.00

[ Ink Check/Change In House (ABC Company)  Testing User, Admin OGA042017  05/04/2017  Good 15.00

[ Ink Check/Change In House (ABC Company)  Testing User, Admin 05/01/2017  05/01/2017 Good 15.00

[J Ink Check/Change In House (ABC Company)  Testing User, Admin 04/17/2017  04/17/2017 Good 25.00

[ Ink Check/Change In House (ABC Company)  Testing User, Admin 04/13/2017  04/13/2017 Good 25.00

[J Update In House (ABC Company) User, Admin 04/03/2017  04/03/2017 Good 25.00

[ Ink Check/Change In Houss (ABC Company) User, Admin VTN QITIRMT Good 25.00 "

Total Cost:

When the item is returned from maintenance, click on the second tab labeled “Maintenance History”

and select the open record by double-clicking on the line item (You can easily find the correct record

because it will have a blank ‘Completed Date’). Now enter the completed date along with notes and a

repair cost if appropriate. Once saved, it is now a completed record in history.

To print the history displayed on the screen, select the Maintenance History tab, then select the Print

Maintenance History button.

To leave the process, select the [XI in the upper right corner of the screen.
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The Check Out process is used to check assets out to a user or location. The Check in process is used to
check assets into storage from a user or location. Check Out and Check In can also be performed on the
handheld unit. To start these processes, select the Check In/Out button.

The Check In/Check Out process is composed of three (3) tabs. The first tab is the Check Out process is
shown below.

& CheckIn/Out ==

‘ @ Reset/ Clear % Remove ltem

Check Out (F1) Check In by Asset (F2) Check In by Person / Location (F3)

Check Out | fﬂ =

‘ CH Save / Print

@ Location  Employee

Barcode: [ [.] Locatiow
Due Date: = EE;:L' tesh T e puer [

Note: |

Asset Barcode: []  Description:

Barcode Description Due Out Condition Person Location Bin Qty Note

User Name: User, Admin Database: Iocalhostiwin_ats

To check out assets:

e Select a Location, Employee or Member to which the asset will be checked out (You can scan the
barcode or click on the ellipses box to look one up)

e If desired, enter the due date for the return of the Asset. Enter a date in the Due Date box, or
enter a Default Interval (number of days from today)

e If desired, enter any transaction notes

e Scanthe Asset barcode (or look one up from the ellipses box)

o If the Asset is a binned item, a box will appear below the barcode to enter the quantity being
checked out

The asset checkout information will be displayed in the grid. To check out another asset to the same
location/employee and with the same due date, scan another asset barcode.

If no scanner is available, you may enter the barcode information into the barcode text boxes and then
press the enter key on the keyboard. You may also select the find button (ellipses) next to the
textboxes to display a list to choose from.

Iltems that are entered into the grid by mistake can be removed by selecting the item and clicking the
Remove Item button.
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Once items are displayed in the grid, the Out Date/Time can be changed by double clicking the “Out
Date”.

All Assets being checked out (including any Binned Assets) will appear in the grid below.

& Check In/Out ==

Check Out E Save % Save / Print @ Reset / Clear E Remove Item

Check Out (F1) 1 Check In by Asset (F2) 1 Check In by Person / Location (F3)

€ Location @ Employes

Barcode: [F005 Employee: Young, Jason —
Default Interval
Due Date = ) Time Due
Note: [Testing

Asset Barcode: ...|  Description:

Barcode [ ipt [Due [Out [Condition Person Location [BinQty |Note
AT MacBook Pro 15" DYU2NT Gooq Young, Jason Testin
02:35 PM 9 9
A1l Acer Chromebook 11.6 Inches Sg’;ﬁ“ﬁf Disposed Young, Jason Testing
091412017
A113 Acer Chromebook 11.6 Inches D3t py Excellent Young, Jason Testing
A109 MacBook Pro 12" S G Young, Jason Testing
A105 8300 gggﬁ,‘w Good Young, Jason Testing
097 Folding Chair g;’ gﬁ“ﬁf Young, Jason 10 Testing
0S4 Asus - 24" LED HD Monitor - Black ggqﬁw Needs Repair ~ Young, Jason Testing

When all desired assets have been checked out and are listed in the grid, select the Save or Save/Print
button. The check out information will be saved and, if Save/Print was selected, the system pop-up a

check-out report which can then be printed, saved, or emailed. The system will then clear the check-

out list.

To cancel the check-out process, select the Reset/Clear button. After confirming you wish to reset the
check-out process, the system will clear the check-out list without saving it.

If you have a long list of items listed in the grid for check-out, you can highlight an individual row and
click the “Remove Item” to remove a single line item from the grid without having to start over.

Checkout can also be performed on a handheld unit.

CHECK IN BY ASSET

To check in an individual asset, select the Check In by Asset tab. The screen will change as indicated
below.

To check an asset into storage, scan the asset barcode or enter the asset barcode and then press the
Enter Key on the keyboard. If the asset is a binned item, a box will appear to enter the quantity being
checked in. The check in information will be entered in the list. Condition, Facility, and Storage

& Check In/Out =3

Check In @ Save C% Save / Print @ Reset/ Clear E Remove ltem

Check Out (F1) | Check In by Asset (F2) 1 Check In by Person / Location (F3)

Asset Barcode: .| Description:

From Person /

Barcode Description Due Return Condition Location Bin Qty Lertinm Status

MacBook Pro 17 D07 | ACME Admin Storage

02:39 PM Administration Room 110
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Location may be changed. Select the column you wish to change, select the Enter key and pick the new
Condition, Facility, or Storage Location from the list.

& Check In/Out

Check In @

Check Out (F1) i Check In by Asset (F2)

Asset Barcode: ...| Description:

From Person /

Condition Location

Description Facility

09/11/2017 ACME Admin Storage

e 02:39 PM Excellent M| 2dministration Room 110 e 1
Delete A
Disposed
End of Life
Excellent

Fixed Assets Deprac
Full

Good

Half Full

MNeeds Reiair

Shredded

Testing Only

Waorking ha

When all assets have been checked in, select the Save or Save/Print button. The check in information
will be saved and, if Save/Print was selected, the system will produce a Check-In report then can be
Printed, Saved, or Emailed.

To cancel the check in process, select the Reset/Clear button. After confirming you wish to reset the
check in process, the system will clear the check in list without saving it.

Check In can also be performed on the handheld unit.
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To check in assets assigned to either an employee or a location, select the Check In by Person / Location
tab.

To check an asset into storage, first select or scan the employee or location barcode the items are
being returned from. A listing of all items checked out to the employee/location will be displayed. You
can then click the check box for each line item being returned or select all. Binned item quantities can
also be changed in the grid if desired by double clicking.

& CheckIn/Out 2
CheckIn H Save [:% Save / Print @ Reset / Clear % Remove Item
Check Out (F1) 1 Check In by Asset (F2) T Check In by Person f Location (F3)
 Location  Employee
Barcode: |[E004 ... Employee: Frank, Amanda
[ Check Al Only checked rows will be checked in Copy Row
OR
Scan Asset Barcode: Change Status: -
Chk Barcode Description Due Return Condition Facility Location Bin Qty | Status
Asus - 24" LED HD Monitor - 09/11/2017
A4 Black 0045 P Good Jobs Chicago
Summit Portable Medical 09112017 ACME Central
A106 Freazer Cooler 02:45 PM Excellent Warehouse Warehouse
" 0ani2017 ACME Central
A107 MacBaok Pro 12 1245 P Excellent Warehouse Warehouse
5 091172017 ACME Central
Al0B MacBoak Pro 12 0045 P Good Warehouse Warehouse
" 09112017 ACME Central
A0 MacBook Pro 12 02:45 P Good Warshousa Warehouse
5 091172017 ACME Central
At MacBaok Pro 15 12:45 P Good Warehouse Warehouse
09112017 ACME Central
A4 Acer Chromebook 11.6 Inches 0245 P Excellent Warehouse Warehouse
09/11/2017 ACME Admin Storage
All5 Acer Chromebook 11.6 Inches 02:45 PM Excellent Administration Room 110
Allin Qne Scanner, Printer, 0912017 ACME Central
ATE Copier 02:45 PM Shredded Warghouse Aisle 1

A Check All option box will check or uncheck all checkboxes for each line item listed. Alternately, you
can scan individual asset barcodes to check the checkbox. You can also change the status to Lost or
Broken for any items checked. The change occurs on Save. If someone returns multiple assets but has
lost others, check-in the returned items first and Save. Then, do a new check-in for the individual and
confirm that the remaining items listed are lost. Check All and Change Status to Lost then Save. The
COPY ROW function allows you to split up binned items being returned if you need to change some to
Lost/Broken.

When all assets have been checked in, select the Save or Save/Print button. The check in information
will be saved and, if Save/Print was selected the system will produce a Check-In report then can be
Printed, Saved, or Emailed.

To cancel the check in process, select the Reset/Clear button. After confirming you wish to reset the
check in process, the system will clear the check in list without saving it.

Check In can also be performed on the handheld unit.
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Reserving Assets is a process used to reserve the use of an asset for a specified period of time. This is
not available in the Starter Edition. To start this process, select the Reserve button. The screen below
will be displayed, showing all reservations that fall within the default date range (one month prior to

current date and five months after the current date). The Reserve Assets process is composed of two
tabs.

The first tab is the Find Reservation process. This is used to view the current reservations for an Asset
or User.

& Asset Reservation

Bl

The Reservation type

Find Reservation (F1] Resenlion Admin [F2)
A determines the type of
Reservation Type: |41 7 . i

P — reservations to display.

Choose from All, Location, or

Msset Barcode: Al

Employee.

Frome [temts ] To:foremte [

To View the reservations for a

user, scan the user barcode
into the user barcode textbox
and the reservations for the
user in the date range
specified will be listed.

To view the reservations for an
asset, scan the asset barcode into the asset barcode textbox and the reservations for the asset in the
date range specified will be listed.

If no scanner is available, you may also enter the barcode in the barcode text boxes followed by
pressing the Enter key on the keyboard. Another option is to select one of the find (ellipses) buttons, to
display a list from which you may select.

If the reservation type is an employee, there will be Bfrom which you can search a list of users. Enter
an employee barcode and select the Extract Data button. If a matching barcode is found, the employee
will appear in the list. Alternately, you can enter a Last Name and select the Extract Data button. All
employees with the entered last name will appear in the list. Select the user desired and then select the
OK button. You may notice that “All” is available. If you select all, then the reservations for everyone
will be displayed.

Select the cancel button to return to the reservation process without selecting a user.

If the reservation type is a location, there will be Bfrom which you can search a list of locations. If the
reservation type is “All”, the find button will be disabled.
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If the reservation type is an asset, there will be B from which you can search a list of assets. Select
the asset desired, and then select the OK button. You may notice that “All” is available. If you select all,
then the reservations for all assets will be displayed.

Select the cancel button to return to the reservation process without selecting an asset.

To change the date range for the reservation list, enter a new date and then select the Enter key or set
the date using the calendar control. The list will change to reflect the new date range.

The reset button will return the screen to the default settings.

The purge reservations button will remove expired reservations from the system. Expired reservations
are those that have a “To Date” that is older than the default “From Date”. They do not appear on the
screen when the reservation form is opened. They can be displayed by setting the “To Date” back to an
earlier date. A message will appear on the screen to confirm the purge operation. It will also show the
number of reservations that will be removed. Respond “yes” to the message to remove the records.

The second tab is the Reservation Admin process. This is used to add new reservations and edit or
delete existing reservations.

g — To add a new reservation, select
gL L & . i the Reservation admin tab. Select
— T o 7 = the add button, choose between
r—— ] (2 Ko location or employee as desired.

il oo Scan the location/employee
T e ) o —= . barcode or select the find button.
el = R I Then scan the asset barcode or

€ High € Medium € Low

select the asset find button. Set
the date range, add a note, and
set the priority as desired. When
completed, select the save button

Asset Barcode: [i) Description

to save the reservation. The

uuuuuuuuuuuuuu imin Datsbsse: CGigaTrakiAsset Tracking Systemhwin_ais.mdb

screen will return to the find
reservation tab, with the new reservation information. To cancel without saving, select the cancel
button.

High Priority — If a Reservation is set to High Priority, and it is the same day as the Reservation, no one
will be able to check the Asset out except for the Location or Employee the item is reserved for. If a
Reservation is set to High Priority and it is sometime in the future, the user will be asked if they will
have the Asset back in time. If they say No, they cannot check it out. If they say Yes, an automatic due
date will be set for them for one day prior to the Reservation.
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Medium/Low Priority — Medium and Low Priority are the same thing and there is no difference
between the two. With a Medium or Low Priority, the user will be prompted and told that the item is
on Reservation but they have the option to override it and check it out anyways.

To edit an existing reservation, find the reservation in the find reservation tab. Select the reservation of
interest, then move to the reservation admin tab. Select edit and modify the information as desired. To
save, select the save button. The screen will return to the find reservation tab, with the newly edited
information. To cancel without saving, select the cancel button.

To delete an existing reservation, find the reservation in the find reservation tab. Select the reservation
of interest, then move to the reservation admin tab. Select the delete button, and then verify. The
system will delete the reservation. To leave the process, select the [X] in the upper right corner of the

screen.

Before setting up Members, you must first create your 3 Member Categories. Please refer to the Setup
Options 2 Member Setup section of the User Manual for more information.

The Members screen consists of two main tabs. The first tab, Find Members (F1), allows you to use a
number of searchable criteria to filter down information. The F1 tab of the Members screen allows you
to Print Member Lists, Print Barcode Lists, Print individual barcode labels, and export to a file. Use the
“Import Members File” option to import a list of a new Members or update a current list.

¢ Members =
Find Members (F1) Members Information (F2)
Find Members
g 1
Enter Barcode Department/Major: L ErenctData | | £ prncLin
Members ID Status.
Print
Last Name Info Field 3 Reset @3 Barcoda List
import
Address Info Field 4 = wembers | [lllll PrincLaver
s File
Category: | All - Status: | Active hd “&. Export List
To File
Barcode Members ID Last Name Names Address E-mail Category Department/Major Status InfoField3  ~
M1 Jones Mary Students Atts Freshman
F003 Kerber Marie Interns Math Non Tenure
M12 Knutson Toby Students Ats Senior
M15 Kupfer Tess Students English Freshman
M18 Losoya Edward Students Music Freshman
FO05 Mader Randall Interns President PhD
Fo04 Mathews Jackson Interns Business Tenure
w11 Mcinnis Alyson Students Math Freshman
M26 Nickson Brian Staff Grounds/Maintenance  Full Time
M28 Pattsrson Nicole Staff Math Dept Intern
24 Pepper Lisa Staff English Dept Intern
mi7 Pontiff Harry Students Music Senior
25 River Jason Staff Janitorial Temp
23 Smalls Jackson Staff Janitorial Part Time
M002 Smith David Students English Sophmore
M10 Stutzman Lita Students English Sophmore
Fo01 Travis Joseph Students Science Tenure Phd
29 Welder Randy Staff Grounds/Maintenance  Temp
MO03 Wilson Dana Students English Junior
v
< >
Double-click to view Members Information 28 rows found

You can download a Sample Import File text from our Client Center on our website.

Username — gigatools Password — gigatools

Click on “Asset Tracking” and look for the Members Sample Import File text.
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http://www.gigatrak.com/client-center/

The second tab of the Members screen, Members Information (F2), allows you to enter a new Member
individually. You must have ‘Member Administration Edit Rights’ to enter a new Member. Click on the
“Add” button. Fill in all required bolded fields and choose one of your 3 categories that you created in
the Setup Options. Fill out any additional un-bolded information regarding the Member. You can Edit,
Copy, Inactivate, or Delete a Member. You will now be able to checkout assets to Members.

’;’ Members
Find Members (F1)
Members Information
Barcode: |8505 Category: |Sludems j ‘”""I" Print
Label
Members ID: | Department/Major: |Market|ng
Last Name: |Davis Status- |Current\
Names: Mary Info Field 3: |
Info Field 4: |

Notes:

Address:

E-mail: |maryd@cc,edu
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Each report has a different set of Report Filters
that the user can select to create the report
results they desired.

Select the report of interest and the report filters
will appear on the right portion of the screen.

Some reports have an Ignore Due Date greater
than a specified date. This is useful if some assets
are checked out to a location or employee over a
long period of time, and you do not want these
assets to appear on monthly reports.

When the filters are set, the user then selects the
Print Report button. A print preview screen will
be displayed from which the report may be

B Reports

Reports

Select Report

Bin Tools Below Reorder Paint

Consumable History by Container
Consumable History by Employee
Consumable Histary by Location
Consumables in Stack by Facility
Consumables in Stock by Location

Expired Warranty by Facility

Expired Waranty in Next 60 Days

Tool Assignment by Class and Type

Tool Assignment by Class, Type and Employee
Tool Assignment by Class, Type and Location
Tool Assignment by Container

Tool Assignment by Employee

Tool Assignment by Employee (Split Pages)
Tool Assignment by Employee (With Responsible Locations)
Tool Assignment by Location

Tool Assignment by Location (Split Pages)
Tool Assignment by Storage Location

Tool Assignment by Tool

Tool Assignment Status by Employes

Tool Assignment Status by Location

Tool Audit

Tool Depreciation by Class and Type

O Print Report

Report Filters

printed, saved as a PDF or Email(ed) (only if Microsoft Outlook is used).

The Asset Assignment, Assignment Status, History by Employee, and Overdue Assets by Employee
Reports give you the ability to Auto E-Mail the report when desired. Select “Email Report(s)” so that
each person gets their own email with their information. Only employees with an email address record
will receive their email report. Your SMTP Host and “From” email address will also need to be inputted

in the Setup Options.

If desired, GigaTrak can provide custom reports at your request. These reports will be quoted

separately and automatically added to the Select Report listing when installed.

velz ATS USER MANUAL

52




Two types of handheld applications are available, batch mode and wireless.

Batch handheld units hold data in a mobile database file that gets transferred back and forth between
the handheld and the host PC. These units will work with both Microsoft Access and Microsoft SQL
Server host databases. The handheld must be docked with the host PC to perform the transfer. The
asset data on the handheld is a snapshot of the data on the host PC. If there are multiple users
changing data on the host database, the handheld data may be outdated in a short period of time.
Therefore, it is important to synchronize the handheld with the host PC often, so that it has current
information.

Wireless handheld units communicate with the host database in real time. This requires the host
database to be Microsoft SQL Server. Your facility will have to have a wireless infrastructure in place
for communication. No data is stored on the handheld.

Communication software must be installed on the host computer. Choose the correct software based
on the operating system of the host computer.

MICROSOFT ACTIVE SYNC INSTALLATION (FOR WINDOWS XP)

1) Locate a copy of the latest version of Active Sync for your computer system. The correct version is
available from Microsoft’s WEB site. Version 4.5 is the latest from Microsoft as of this printing.

2) Look for the installation file (i.e. activesync_setup.msi) and run it. We recommend that you follow
the installation instructions and accept the standard default settings during your install.

3) Leave Active Sync running to install and connect your handheld computer.

NOTE: Some users may use a single PC to connect multiple handheld computers. If this is the case, it
is best to setup your PC to recognize each handheld as a “Guest”. This avoids having Active Sync
loading shared data from your Outlook and other PC applications. To set all connected handhelds as a
Guest, please double-click and run the provided “GuestOnly.reg” file. It will instantly update your
system for future connections.

WINDOWS MOBILE DEVICE CENTER INSTALLATION (FOR WINDOWS VISTA OR NEWER)

1) Locate a copy of the latest version of Windows Mobile Device Center for your computer system.
The correct version is available from Microsoft’s WEB site.

2) Look for the installation file (i.e. drvupdate-x86.exe) and run it. We recommend that you follow the
installation instructions and accept the standard default settings during your install.
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The handheld application can be found in the Handheld folder of your installation download.
1) Connect the handheld docking station to your computer (typically a USB connection) and plug in the

AC power cable.

2) Put the handheld in the dock (if required) or sync via USB and wait for it to sync with the PC.
3) Onthe PC, double-click the handheld setup file for the application you are installing (e.g.,

setup_honeywell_hh.exe).

The batch handheld must be synchronized with the Asset Tracking application on the host computer
before it can be used. This will load the current tool information onto the handheld.

1) Start the Asset Tracking application on the host computer and select the Download button.
2) If your handheld device is not displayed on the screen title bar, click the Select Handheld button

and select it.

3) Put the handheld in the dock (if required) or sync via USB and wait for it to sync with the PC.
4) Select the Sync Data Automatically button to begin the data transfer. Do not remove the
handheld from the dock until the data transfer is complete.

The following describes basic operation of the Mobile Asset Tracking application.

HANDHELD APPLICATION LOGIN

When the handheld application is first started, a user login will be required.
Scan an employee barcode, or type in an employee barcode and press the
Enter key. If the barcode matches an employee in the data file, the
employee name will appear under the scan box, and buttons for the

m 1'.'..’ 1— i 3:26
o°
ggatra<

Asset Tracking System
w4,17.0

Scan / Enter Employee Barcode:

|al:|min " Log Out |

User: User, Admin
| Check Out | ‘

Check In ‘

| Audit | \ Count Bin \

| Identify H Maintenance ‘

2014 GigaTrak. Al rights reserved,

velz

application functions will appear.

The user barcode is tied to the records

[ & 4 @ 3:25

@
gigair<
Asset Tracking System
v4.17.0
Scan / Enter Employee Barcode:

| [oon |

2014 GigaTrak. Al rights reserved.

recorded by the handheld. If a different employee uses the handheld,
he/she should enter their barcode before recording records. To

change the user barcode, select “Log Out” and enter in a different

employee barcode. The Maintenance function on the handheld scan

be turned on or off in the Setup Option under Application Settings.
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WIRELESS APPLICATION LOGIN 7 | start

Admin

When starting the wireless handheld application for the first time, you will SOL Server Name / IP Address:

be prompted to enter the server name in Admin. Select the Admin button | |

to display the Admin screen. You will be prompted to enter a password Database Name:

when you select this function. The password is admin. If you are entering | |

the password on the handheld keypad, be sure you are in alpha mode. [ < Backtovena ] o )

WIRELESS APPLICATION ADMIN

Display the on-screen keyboard and enter the SQL Server Name or IP

Address and the database name (typically win_ats). u

Select the Save button when finished. A message will be displayed to indicate that the settings have
been saved. Select the Back to Menu button. Scan or enter your employee barcode to log into the
application. The main menu buttons will be displayed as shown above.

CHECK OUT

The Check Out function is used to assign assets to employees or locations.

Scan the barcode of the employee/location that is receiving the assets. If the barcode matches a record
in the data file, the appropriate name will be displayed under the scan Check Out [ & o @ 3:34

dn
box Check Out
Employee/Location Barcode:

Scan the asset barcode. If the barcode matches a record in the data file, |:::t1h — |
the asset description will be displayed under the scan box. If the assetis | yote:

not a binned item, the check-out record is saved. If the asset is a binned

item, the “Qty” box will appear, with a default quantity of one. Enter

the appropriate quantity and press the Enter key to save the check-out e Bareace

Asset checked out successfully.
record. ADD1 - Compact Desk - Left 2-Drawer
Last Loc/Emp: Warehouse

Continue to scan the asset barcodes that will be assigned to the

employee/location. 1 data records

| <- Back ko Menu | | Reset

The Reset button will clear data from the screen without saving it. It will
not reset data that has already been saved.

CHECK IN

The Check In function is used to return assets from an employee/location back to a storage location.

The user can change the Asset Status from a drop-down list at the time of check in. The options are No
(change), Lost, or Broken.

Scan the asset barcode being returned. If the barcode matches a record in the data file, the
appropriate name will be displayed under the scan box. The current storage location will be displayed.
If the asset is being returned to this location, just press the Enter key. If it is being returned to a
different storage location, scan the barcode of the new storage location.
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0 Rk ArE=ED If the asset is not a binned item, the check in record is
Check In saved. If the asset is a binned item, the Qty box will appear,

Change Asset Status: with a default quantity of one. Enter the appropriate

|A55Et Barcode: | quantity and press the Enter key to save the check in record.
ADO1

A001 - Compact Desk - Left 2-Drawer Continue to scan the asset barcodes that will be checked in
Last Loc/Emp: Smith, John

from the employee/location.

New Storage Location: Note: Consumable items cannot be checked in. Scanning
|MME| | the barcode of a consumable item will display the message
Warehouse

“Cannot Check In a Consumable”.

The Reset button will clear data from the screen without
ldatarecords | sgying it. It will not reset data that has already been saved.

| <- Back to Menu |

AUDIT

The Audit function is used to verify assets that are at a specific Location or with an Employee.

Scan the barcode of the employee/location that is being ﬂ 4'.'.'." of @ 3:40
audited. If the barcode matches a record in the data _A”dit

file, the appropriate name will be displayed under the |T:;Z:Ziézcatlun Barcode: |
scan box, and a list of the assets that are currently T —

assigned to that barcode will appear in the list box. Asset Barcode:

Note: Binned assets are not audited, and will not be | |

displayed.

A001 ~ Compact Desk, - Left 2-Drawer
Now, perform your Audit by going around and scanning iig? o r?q'—'mgit E'I'F‘rtﬂ?zenf"'ﬂdi':a' Freezer Coold

e Macood gul
all of the Assets you find at that Location/Employee. 54108 ~ MacBook Pro 12"
) 4110 ~ MacBook Pro 12"

If the scanned barcode matches one of the barcodes in 4111 ~ MacBook Pro 15"

A114 ~ Acer Chromeboak 11,6 Inches

the list, that item will be removed from the list.

. . ] 0 data records
Continue to scan the asset barcodes, including barcodes

that do not appear in the list. When all assets have been Aok o e | =5

scanned, there may be some items still on the list.

Those items can be reconciled when the data is downloaded back to the host PC.

The Reset button will clear data from the screen. Tools that were audited will have been saved.
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COUNT BIN

Count Bin ﬂ ;I? o2 @ 3:47 The Count Bin function is used to count the number of Binned items in
Count Bin a Storage Location. (Verify stock inventory)

Asset Barcode:

|Mgﬁ | Scan the asset barcode. If the barcode matches a record in the data

4096 - 1 Roll Paper Towel file, the appropriate name will be displayed under the scan box. If the

Last Lac/Emp: Aisle 2 barcode does not match a bin item, the message “Not a binned item”

is displayed.
Enter the number of binned items counted for that barcode in the
ity: .
?;:" nid | Quantity box and press the enter key to save the record.
The Reset button will clear data from the screen without saving it. It
will not reset data that has already been saved.
0 data records
| <- Back ko Menu | | Reset |
IDENTIFY
The Identify function is used to display the description of an asset Identify [ & 4 @ 3:50

when the barcode is scanned. It will also show the last known Identify

Asset Barcode:
78 |

A78 - All in One Scanner, Printer, Copier
Last Loc/Emp: Aisle 1

location or employee that has it. This is only a lookup function, it

does not save data.

0 data records

<- Back ko Menu

When you have finished collecting data, the batch handheld must be downloaded back to the host PC
application.
1) Start the Asset Tracking application on the host computer and select the Download button.
2) If your handheld device is not displayed on the screen title bar, click the Select Handheld button
and select it.
3) Put the handheld in the dock (if necessary) or sync via USB and wait for it to sync with the PC.
4) Select the Sync Data button to begin the data transfer. Do not remove the handheld from the
dock until the data transfer is complete
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The data collected on the handheld will be displayed on the screen. At this point, none of the asset
data has been changed in the host database. Click the Commit button to commit the data to the host
database. Only the rows that are checked in the first column will be committed. The user can check or
uncheck the checkboxes as appropriate. This will prevent bad data from being committed to the
database.

Some data can be modified before using the Commit function. For a count record, the Qty counted can
be changed by double-clicking the Qty. For a check in record, the Status can be changed by double-
clicking the Status Change column and selecting from the dropdown list. Be sure to check the checkbox
in the first column if you want the data to be changed.

After the Commit function has been performed, it changes data in the host database. The background
of the checkbox will turn yellow for committed items. All handhelds should be synced with the host to

update the data on the handhelds. Once all items have been committed to the host PC, it is a good idea

to clear the screen. The System will ask Twice if you are sure you would like to clear. As long as all items
are yellow that you want committed, you are good to clear.

DOWNLOAD SCREEN

The system provides for a handheld scanner download process. The user must first configure the PC for
the handheld in use (See Handheld Configuration). The Handheld Configuration screen can be
displayed by choosing the Select Handheld button. The selected handheld device is shown in the blue
banner of the Download screen.

Check in/out records can be mixed with audit records and count records on the handheld unit. When
the unit is downloaded, the records will be shown with the appropriate type displayed. The records
displayed can be limited to a specific type by clicking the appropriate Display Type button.

When a handheld unit is ready for download, select the Download button from the main screen. The
form below is displayed.

[F— S * Batch handhelds must be loaded
=] Bes) (LS @) Mo Bim] [amee with a reference file before they
R [ e - can be used. Dock the handheld to
P P T en W o mEE e auswe | the host PC and select the Sync
:: 13- Loy —— <, Data button. Handhelds should be
® 0c sub i synced with the PC before each

Ot Smih, koin Smith, Johm

e use to ensure that they have the

Smith. Johm

¥ Ot Smih kin

Ot Ofce 102Man Ofics) & - o

latest data.

If there are download records
stored in the temporary database
table, the grid will display the

& mows found

existing downloaded records. New
handheld records can be added as long as the existing download has not started the commitment
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process. If commit has been started or the handheld audit is separate from the existing audit, then the
existing records must be completed and cleared from the database prior to uploading the new
handheld records.

To download handheld data, place the handheld in the downloader, select the Sync Data button, and
follow the on-screen instructions.

If the download is successful, the grid will be rebuilt with the new records. If the records were
downloaded successfully but there were some problems, the system will provide a message and the
problems will be documented in a log file. This file can be viewed and printed by selecting the View Log
File button. Note that the log file will be deleted whenever a new Sync Data function is performed.

If a checkout record is recorded on the handheld for an item that has a high priority reservation for a
different employee than the one entered on the handheld, the text will be displayed in blue. The Chk
column can be manually checked to allow the checkout of the item to the scanned employee, but this is
not recommended. Always check with the employee who originally reserved the item on the
Reservation screen before allowing the item to be checked out.

The Commit button will save the information in the downloaded records that have been checked to the
permanent portion of the database. The background color of the checkbox will turn yellow after those
records have been committed. The Commit function may be performed several times. Records that
were previously committed will be skipped. Once a Commit function has started, no further downloads
will be accepted from a handheld until the downloaded records are cleared.

IMPORTANT! -- The Commit function changes asset data. A message will appear to alert the user to
sync all handhelds with the PC to update the reference file on the handheld.

COMMIT AUDIT TO THE DATABASE (BATCH MODE AND WIFI)

When performing an Audit with the Handheld, both Batch and Wifi Connections will need to Commit
their Audit. There could be some erroneous data in the grid. Therefore the system will only commit
those records that have the Chk column checked. During download, the system will check those
records where the audited location matches the expected location, however the user may change the
value if desired. This allows the user to control what records will be loaded into the database. If the
audited location does not match the expected location, the text will be displayed in red.

The Save Changes button will save the changes in the Chk column to the temporary audit table in the
database. This does not change any asset data.

IMPORTANT! -- The Commit function changes asset data. A message will appear to alert the user to
sync all handhelds with the PC to update the reference file on the handheld.

The Clear button will remove all records from the temporary download table in the database, making
way for new download information. The system displays a warning message prior to clearing the
records.

The Report button will print a report of the records displayed on the grid.
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GigaTrak provides 90-days of telephone support for ATS from the date of purchase. GigaTrak will
advise on installation issues but the customer is responsible for network and SQL Server installation.
Our hours are 9am to 5pm central time Monday through Friday. During this time you are entitled to
any updates or new releases issued by GigaTrak. By purchasing an annual support agreement, these
services are extended during your support term. Onsite support is available at additional cost. Please
call 262-657-5500 extension 2 with any questions.
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